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ZaSPACR.

« On starting Project a blank template will appear.

& Microsoft Project - Project1

:@ File Edit Yiew Insert Format Tools Project Window Help Ej)_ﬂ
DEHSRY sad . @ g EE B ¢ B Mocow - ®ReT w3,
(€ % 4 = show- | Al 8 + B I U|===|aTasks |
@ | TaskName Duration [ Jul 18, '04 [ | A | Mg 8,04 [ A | Aug 22 '04 |Aug29,'04 =
W|T|F|S|S|M|T|WITIF|S|S MlT|W|TIF|S|S|M|T|W|TIF|S|S|M|T|W|TIF|S|S|M|T|W|TIF|S|S|M|T|W|TIF|S|S|M|T|WI

L1
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Bﬁlfiniig Basic Project Information

ZaSPACR.

* From the “Project” menu select “Project Information” and
enter the anticipated project start date.

Project Information for ‘Project1’ E| El

Skark date; m

Finish date: jrﬂun 7126/04

Lel Lo o

Schedule From: |F'r|:|ject Start Date

All kasks begin as soon as possible,

Current date: |M|:|n 7lz6/04

KA NERNEN

Stakus date: |r~m
Calendar: j Standard
Priority: [s00 =
Help | Statistics... | K Cancel |
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Y Ballooning Enter the major tasks

Course

ZaSPACR.

* Type in the major tasks (WBS level 1) in the “Task Name” box.
« Each row 1s a separate task
* Do not worry about the rest of the columns for now

& Microsoft Project - Project1 E]@ X

:@ File Edit WYiew Insert Format Tools Project Window Help _;ljj_’_‘_l
D SEY|é B ol = B N = & & # (3
Show = | A - - B A | = = [asks A || EE

X | Data Archive U

(5 ] Task Mame Duration Start Finizh |Predecessors |Rid, 05 Jan 23, '05 Jan 30,05 Feb B, '05 -
| it lrlslsm[TwlT[Fls(sm[T T ]F s |sM]|T W]T]F]E

| Porver System [ 1day? Mon 1024M5  Mon 102405
2 Flight Cortrol Unit 1 day?  Mon 152405 Mon 12405

E
“ 1 |Data Archive U
o |-

| Enker | et | [eaps | UM el [oyR
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LaSPACK.

« Select the row above which you want to insert a subunit
« Seclect “New Task” from the “Insert” menu
» To delete a row, select the row and press the “Delete” key

-& Microsoft Project - Project]

Insert Rows

Ea File Edit Yiew Insert Format Tools Project ‘Window Help
NEH SRY | 1 2RC @ =i B ¢ @ koo . 8Qr ®E.
d 5 & = show~ Al ~85 - B I U == = |alTasks - T2 | L
(5] Tagk Mame Dur sticn Start Finizh Predecessars R Jan 23,05 Jan 30,'05 Feb 605 !f_l;
[ [ | | siM[TIw[T[F]s|sIM]T[wT[F[s|sM[T w[T]F[s]S
= 1 Power System 1 day?| Mon 12405  MWon 1/2403 H i R
calendar | [~
= 1 3
et | 4
s
:
=" g Flight Control Unit 1day? Mon 12405  Mon1/2405
: ) Data Archive Unit 1 day?| Mon 12405  MWon 1/24/03
10 Data Archive Disk 1day?  hon 12405 Mon 1524005
11 Avziliary Transmitter 1 day?| hon 12405  hon 1/24/05
12 Mechanical Structure 1 day?| Mon 12405  MWon 1/2405
13 Thermal Control 1 day?| Mon 12405 MWon 1/2403
— 14 System Integration & Test 1day?  Mon 12403 don 124035
=TT . !
= 15 Management 1 day?| hon 12405 won 1/24/05
£| F |1 »
Ready MM
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LaSPACK.

* Type in the name of the subunit task in the “Task Name” field

e Subunits are “indented” with the right arrow on the task bar

* When subunits are so “indented” the major unit will become
bold and the Gantt chart bar will change shape

& Microsoft Project - Projectd

@ File Edit Yiew Insert Format Tools Project Window Help ﬂ?ﬂ
DR SRY $BRYL v @ =88 5@ Neow - Ry @,
& & & = show- | Al -8 | B T U === alTasks - | L
Inktegrate & Test
i) Task MName Duration Start Finizh Predecessors  |Fa Jan 23, '05 | Jan 30,'05 | Feh B, '05 [Fra]
= | | | | | | smlThwT[Fls[siM[TwTIF]sism|Tw[TIF[s]s
1 = Power System 1day? Mon 12405 Mon 1/24/05 : : i
Calendat 2 Pouver Source 1 day?  Mon 12405 Won 1/24/05
3 FCU Supply | 1 day?  Maon 152405 Mon 152405
1 4 DAL HD Supply 1 day?  Mon 12405 Mon 12405
5 DaU Supply 1day?  Mon 12405 Maon 1/2405
o B CubeSat Supgly 1day?  Mon 152405 Mon 124105
- 7 | Integrate & Test | 1 day? | Mon 12405 Mon 1/24/05
E — g Flight Control Unit 1 day?  Mon 152405  hon 152405
fE ] Data Archive Unit 1day?  Mon1/24005  Mon 152405
10 Drsta Archive Disk 1 day?  Mon 152405 Mon 142405
-|| - 11 Auxiliary Transmiter 1 day?  Mon 152405 hon 152405
: 12 Mechanical Structure 1 day?  Mon 124035 Mon 152405
Lsage 13 Thermal Caontral 1 day?  Mon 152403 Mon 124105
— 14 System Integration & Test 1 day?  Mon 12405 Maon 152405
= 15 Management 1 day?  Mon 172405 Mon 152405
~ | FI gllal e | >
-Reaciy Ex ! NLII;\"i F i -
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Ballooning Complete entering WBS
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R Course
LaSPACK.

* Process of inserting rows, typing in the task name and indenting
the subunit continues until all tasks in the WBS are entered

‘& Microsoft Project - Project1

@ File Edit “ew Insert Format Tools Project ‘Window Help ﬂ}ﬂ
D SRy $BR<C v @ =i &5 & & Neop - B AT @ .
|4 & & = show~ | Arial -8 | B I U|= All Tasks - T L
a Task Mame Duration Start Finizh Predecessors  |R[Jan 23, '05 Jan 30, '05 Feh B '05 &
| | | | | et wlTFle[smTWwT[Fls[sM[T v

1 Power System 1day? Mon1/2405 Mon 12405 vy

2 Powver Source 1 day?  Mon /2405 Mon 1724005

3 FCU Supply 1 day? Monid I24IDSI Maom 12405

4 DAL HD Supply 1day?| Mon1/2405 Mon 152405

5 DAL Supply 1 day?  Mon .r24,r05' haon 172405

E [=] CubeSat Supply 1day? Mon 124105 | Mon 1/24/05

7 Interface to power source 1 day? Moni I24IDSI Mo 1 I24IDSI

] [l FCU Control Interface 1day? Mon1/24/05 Mon 1724105

a | Establizh Control Requirements 1 day? Moni .r24,r05' haor 172405

10 Design control interface 1 dday?  Mon1/2405 hon 102405

1| | Prototype & test design 1day? Mon1/2405  Mond/24i08

72 | [ Complete design 1day?  Mon1/24M05  Mon 12405

13 | Implement & test design 1 day?  Mon .r24,r05' haon 172405

14| DCDC Converters 1 day?  Mond .l‘24.l’05. bon 12405

15 | | FCU Monitoring Interface 1day?| Mon1/2405  Mon 1524005

15 | [ Irtegrate & Test 1day?  Mon 12405 Mon /2405,

17| Flight Contral Unit 1 day?  Moni .r24,r05' haor 172405

18 Diata Archive Unit 1 dday?  Mon 12405 Mon 102405

19 | | Data Archive Disk 1day? Mon1/2405  Mond/24i08

20 | | Ausiliary Transmitter 1day?  Mon1/24M05  Mon 12405

| Mechanical Structure 1day?  Mon 12405 Mon 12405

29 | Thermal Cortral 1dlay? Mon1/2405  Mon/24005

23 | | System Integration & Test 1day?| Mon1/2405 Mon1/24i05

24 | Management 1 day? Mon1.l‘24.f05: Mar 1/24/05 -
ozl | : 2
Feady =T f NUM
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P Balloning Display the WBS code
gy, Course
» Select the “Information” column, right click and choose “Hide
Column™.

* Next select the “Task Name” column and from the “Insert”
menu select “Column™. The following pop-up will appear.

e Choose “WBS” as the “Field name”

Column Definition

Field narme:  [BIE - ak
_ WAC -

Tikle: iZancel
- |'"WES Predecessors _
Align titles yups 5 ccessors Best Fit

it Wiork
Align data Work Conkour .
Work Wariance -
width: g

LSU rev20AUG2020 L24.02 MS Project Example 8



Ballooning Showing the WBS code

Course

ZaSPACR.

e The correct WBS code number will now be displayed for all
tasks

crosoft Project - Project1

@ File Edit Wiew Insert Format Tools Project wWindow Help
DEHESRY I RART @ ek @cB wver - QAT @d.
@ & &+ = show- | aal -5 -|B 1 U = | Al Tasks - T L
1
WBS Tazk Mame Duration Start Finish Jan 23, '05 Jan 30, '05 Feb £ '05 Fa
| | | sisMmTwTIFssm[Tw[T[FlssM|Tw[T[F[s sj
i l:] Power System 1day? Mon 1724/05 Mon 1/24/05 vy
2 1.1 Powver Source 1 day?  Mon 1.!‘24.!’05. hdon 152405
3 1:2 FCU Supply 1 day?  Mon 1.!‘24.!’05. bdon 1/24/05
4 13 DAU HD Supply 1day?  Mon 12405 Mon 102405
5 | 1.4 DAL Supply 1 day?  Mon 1.!‘24.!’05. hdon 1524105
& | 15 =l CubeSat Supply 1day? Mon1/2205 Mon 12405
7 1.51 | Interface to povwer source 1 day? Mon 1.!‘24.!’05. tdon 1/24/105
g 1.5.2 =l FCU Control Interface 1 day? | Mon 1723105 | Mon 1124105
a | 15241 | Establish Cortrol Reqguirements 1 day? Mon 1.!‘24.!’05. hdon 124105
10 1522 Design control interface 1day?  Mon 12405 Man 102405
EiE| 1523 Prototype & test design 1 day? Mon 1.!‘24.!’05. bdon 1/24/05
12 | 1524 Complete desion 1day?  Mon 12405 Mon 102405
13| 1525 Implement & test design 1 day? Mon 1.!‘24.!’05. hdon 1524105
14 153 DCIDC Canverters 1day?  Man1/2405  Man1/2405
15 | 154 FCU Monitoring Interface 1day?  Mon 12405 Maon 102405
16 | 16 Integrate & Test 1day?  Mon 12405 Mon 102405
17| 2 Flight Control Unit 1day?  Mon 12405 Mon 102405
18 3 Drata Archive Unit 1 day?  Mon 1.!‘24.!’05. hdon 152405
19 | 4 Data Archive Disk 1day?  Mon 12405 Mon /2405
20 5| Auxiliary Transmitter 1day?  Mon 12405 Mon 102405
] B Mechanical Structure 1 day? M0n1.l‘24.f05. hdon 1524105
22 7| Thermal Cortrol 1day?  Mon 12405 Mon 12405
23 8. System Integration & Test 1 day?  Mon 1.!‘24.!’05. tdon 1/24/105
24 | 8 Management 1day?  Man 1r24ro5: hion 1/24/05 -
Egh) KT dlg = ;IJ
| Ready Eplnll i e MM F
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« With all subunits inserted the lowest level will be blue
rectangles and higher levels will be black bars with points on

the ends.

Task bars

@ File Edit Wiew Insert Format Tools Project Window Help ﬂ_XJ
DEE &Y $BRT o @ =i B &8 NGop -Gz @,
| 4@ @ & = show- | Al 8 =B Z U = | all Tasks . T | L
Power Source
WBS Task Mame Duration Start Finish Jan 23, '05 Jan 30, '05 Feh B, '05 F‘ﬂ
| | sismTw[TIFlssMTw[TIF[s[sm T T[Fs]s
2 14 [ Power Source 1day? Mon 12405 Mon 12305 ey 0
4 12 FCU Supply 1day? Mon1/2405 Mon 124105 o
5 13 [ DAU HD Supply 1day? Mon 172405 Mon 1/24105 =y
8 14 [+ DAU Supply 1day? Mon1/2405 Mon 12405 vy
10 1.5 CubeSat Supply 1day? Mon1/2405 Mon 124105 e
1 151 Interface to power source 1day? Mon1/2405 Mon 124105 L
13 152 | FCU Control Interface 1day? Mon 124005 Mon 124105 =y
14 | 1521 Establish Control Requirements 1day? Mon1/2405  Man 1724005
15 | 1522 Design cortrol interface 1dday? Mon1/2405 Mo 172405
16 1523 Prototype & test design 1day?| Mon 172405 Mon 152405
17 | 1524 Complete design 1dday? Mon1/2405  Wond 24005
18 | 1525 Implement & test design 1day? Mon1/2405  Man 152405
19 1.5.3 ¥ DC/DC Converters 1day?  Mon 12405 Mon 1/2405 L
2 154 [#| FCU Monitoring Interface 1day? Mon 1/2405 Mon 172405 L o
23 16 # Integrate & Test 1day? Mon 1724005 Mon 1/24105 =y
25 2 [ Flight Control Unit 1day? Mon 12405 Mon 124105 L=
27 3 [ Data Archive Unit 1day? Mon 172405 Mon 1/24105 gy
29 4|+ Data Archive Disk 1day? Mon 12405 Mon 1/2405 -
31 5 [# Auxiliary Transmitter 1day? Mon 1/24/05 Mon 1/24/05 =y
33 6 ¥ Mechanical Structure 1day? Mon 1724005 Mon 1/24105 vy
35 7 hermal Control 1day? Mon1/2405 Mon 172405 L
37 8 [ System Integration & Test 1day? Mon1/2405 Mon 1724105 oy
39 9 ¥ Management 1day? Mon1/2405 Mon 12405 =y
Temizdled | B = ;|J
Ready MUM F

LSU rev20AUG2020
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LaSPACK.

* You can change the color of the task bar to distinguish between
the different levels in your WBS

« Select the task bar to change (in the Gantt chart area), right click
and select “Format Bar”.

« Change the color of the “Start”, “Middle” and “End”
| Format Bar @

Bar Shape ] Bar Text l

Skart Middle End

S I'—:I e :J e "—ll
Tvpe: |S|:|Ii|:| T] Pattern: |_ :J Type: Solid 71
Calar: |. Black. - Color: Color: ([ Black vl

Sample:

B Red
] vellow
FD Lirne:
O Aqua
B clu=
B Fuchsia

Help | [] whike k. | Cancel

B Maroon
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7 Studen
% e Results after task bar change

* The results of changing the task bar color are shown below

& Microsoft Project - Projecti

@ File Edit Wiew Insert Format Tools Project Window Help ﬂ}ﬂ
Dzl &ay i 2R < W = cEr B & & NoGowp - | @S (T,
|4 & 4+ = show~ | Aral ~8 - B I U =E=E = alTasks - T AN L
WBS Taszk Mame Duration Start Finist Jan 23, '05 Jan 30, '05 Feb £, '05 F
| | | | ElsMTiw[T[Fls[sMITWITIF[s[sM[TWTIF[S sj
1 1 = Power System 1day? Mon 12405 Mon 1/24/05
2 141 Power Source 1 day? Mon 124105 [ Mon 1/24/05
4 1.2 [# FCU Supply 1 day? Mon 12405 | Mon 1/24/05
g 13 DAU HD Supply 1day?  Mon 172405 Mon 12405
g | 1.4 DAU Supply 1day? WMon 1/24/05 | Mon 12405
10| 15 =l CubeSat Supply 1day? Mon 12205 Mon 124105
11 151 [ Interface to power source 1day? Mon 172405 Mon 1/24/05
1@ | 1.5.2 = FCU Control Interface 1day? Mon 12305 Mon 1724105
14 | 1521 Establish Cortral Requirements 1 day? Mon 12405 Mon1/24/05
15 1522 Design control interface 1 day?| Mon i I24.I’DS' Mon /2405
16 | 1523 Praototype & test design 1 day?|  Moni I24IDSI Man 1724005
17 | 1524 Complets design 1 day?| Mon1/2405  hon 112405
18 | 1525 Implement & test design 1 day? Mc-n1."24.f05. Maon 1724005
19 | 153 [ DC/DC Converters 1day? Mon 12405 Mon 1/24/05
7| 154 # FCU Monitoring Interface 1day? Mon 12305 Mon 1724105
| 16 #l Integrate & Test 1day? Mon 12405 Mon 1/24/05 =y
25 | 2 | Flight Control Unit 1day? Mon 12305 Mon 1/24105 =y
2y 3 [+ Data Archive Unit 1day? Mon 12405 | Mon 112405 Lo
29 4 [ Data Archive Disk 1day? Mon 12405 Mon 1724/05 o=
31 5 [ Auxiliary Transmitter 1day? Mon 12205 Mon 124105 )
33 6 |+ Mechanical Structure 1 day? Mon 1/24/05 Mon 12405 =y
35 7| Thermal Control 1day? Mon 12405 Mon 172405 y
37 8 [ System Integration & Test 1day? Mon 172405 Mon 1/24/05 =y
39 | 9 ¥ Management 1day? Mon 1rzcunsi Mon 1/24105 =g _
x| M : Ml '
| Ready E T | R UM
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Hillooaitg Set the task durations
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LaSPACK.
« Now enter the time associated with each task in the “Duration”
field. See the MS Project Help for choices on units.

» Set durations for the lowest level tasks and the total time will be
summarized or rolled-up to the next highest level.

crosoft Project - Example Project.mpp

@ File Edit Yiew Insert Formab Tools Project Window Help EJH
DeE Sy LBRT v« @ e=dea B ¢ & Mo - B @ E.
& & & = Show~ Aral -8 - = | &l Tasks S 1
Systern Integration & Test
WWBS Tazk Maime Durstion Start Finish Predecessors  |Re Jan 23,'05 Jan 30, '05 Feb B '05 Feb13,'05 «
| | SeMITWIT[FIS = [M[T [T IF[5 (5 [MITMWITIF[S sTr\Ti'T\'V\j
1 1 = Power System 10 days Mon 12405 Fri 24105 L . . 2
2 1.4 [* Power Source Sdays Mon1/2405  Fri 128105 e
4 1.2 F FCU Supply 10days Mon 172405 Fri 21405 =
3 13 [ DAU HD Supply 5days Mon1/24105  Fri 12805 P——
8 14 DAU Supply 10 days Mon 1/2405  Fri 2/405 e =
10 15 = CubeSat Supply 4days Mon 124105 Thu 127105 T—
11 151 [+ Interface to power source 2 days. Mon 124005 Tue 125105
13 152 =1 FCU Control Interface 4days Mon 124005 Thu 127105
4 1521 Establish Control Requiremerts 4 day  Mon 12405 Mon1/24105 i)
15 1522 Design control interface 2days  Mon 172405 Tue 1/25/05
16 | 1523 Prototype & test design ddays  Mon 12405 Thu1/2705
17 | 1524 Complete design Tdday  Mon 12405 Mon 172405
18 1525 Implement & test desian 2days Mon 152405 Tue 1/25/05
° 153 ¥ DC/DC Converters 3days Mon 12405 Wed 12605
21| 154 | FCU Monitoring Interface 3days Mon 122405 | Wed 126105
e | 16 = Integrate & Test 3days Mon 12405 Wed 1/26/05 P—
zantt 25 | 2 & Flight Control Unit 10days Mon 12405 Fri2/405 @ %
i 27 3 ¥ Data Archive Unit 10 days Mon 172405 Fri 214105 L Yy
m 29 4 ata Archive Disk 3days Mon 1/24/05 | Wed 1,26/05 p——
& 2 bt | 5 Auxiliary Transmitter 5days Mon 1/2405 | Fri1:28/05 PE———
33 6 [ Mechanical Structure 10 days Mon 1/24/05 Fri 2/4/05 W .
35 7 # Thermal Control Sdays Mon 1/24105 | Fri 1:28/05 PEE——
a7 8|t System Integration & Test I 6 days Mon 1/24105 | Mon 13105 L .
EE 9 = Management 50days Mon 12405  Fri 4105 ¥ =
izl el | Bl mi f‘
Ready = UM '
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Set the task predecessors

 Enter the task dependence (1.e. which tasks must be complete

prior to starting the next task) in the “Predecessors™ field.

* You need to use the row number, not the WBS code.

Microsoft Project -

Example Project.mpp

@ File Edit Yiew Insert Format Tools Project Window Help i]ﬂ
DEESRY $RET o @ = B @ mwaow /e .
@ % F = Show- | Aral w0 =B gl Al Tasks - e L
WBS | Task Mame Duration Start Finist Predecessars  |Re Jan 23, '03 Jan 30, '03 FekB,'0
| | | | FlelsmTwTIFIslsm[TwITIFIS[sM]T

1 1 = Power System 10 days Mon 172405 Fri 2/3/05 ¥ L

2 11 [* Power Source S5days Mon 12405 Fri 1:28/05 e

4 1.2 [+ FCU Supply 10 days = Mon 1/24/05 | Fri 2/4/05 F =

5 13 + DAU HD Supply Sdays Mon1/2405  Fri 12805 ——

g 1.4 [+ DAU Supply 10 days = Mon 1/24/05 | Fri 2/405 b ¥

10 15 =l CubeSat Supply 10 days = Mon 1/24/05 | Fri 2/4/05 i %

11 151 [+ Interface to power source 2 days Mon 1/24/05 | Tue 1/25/05

13 152 CU Control Interface 10 days Mon 12405 Fri2/405

14 | 15241 Establish Control Requirements 1day  Mon 1.!‘24!05. Mon 1724105

15 1522 Design cortrol interface 2days|  Tue 102505 Wed 12605 14

15 | 1523 Prototype & test desion 4 days | Thu 12?!05. Tue 2A05 15

17 1524 Complete desion ey Wed 22005 Wed 202005 16

18 1525 Implement & test design 2 days Thu 243105 Fri2i4ins 17

19 153 [ DC/DC Converters 3days | Mon1/2405 Wed 1:26/05 :l

el 1.5.4. CU Monitoring Interface Jdays  Mon 172405 | Wed 1/26/05 i

23 1.6 # Integrate & Test 3days | Mon1/2405 Wed 1:26/05 g—

23 2 light Control Unit 10 days  Mon 1/24/05 | Fri 2/4/05 L 4 . 4

27 3 ata Archive Unit 10 days  Mon 1/24/05 Fri 2/4/05 L 4 . 2

29 4 ata Archive Disk Jdays Mon 12405 [ Wed 1/26/05 p——

31 5 Auxiliary Transmitter S5days Mon 12405 | Fri 1:28/05 ! P

33 [ Mechanical Structure 10 days  Mon 1/24/05 | Fri 2/405 L . 4

a5 T hermal Control 5days Mon 1/24/05 | Fri/28i05 L

37 3 System Integration & Test 6 days  Mon 1/24/05 | Mon 1/31/05 I e NS

3 9/ [ Management 50days Mon 12405 Frid/ins T

T -
e KN el | f
| Reaciy .

LSU rev20AUG2020
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R Course
Z£aSPACK.

« Here all the task predecessors are determined and entered, but
the Gantt chart now needs room to display fully

& Microsoft Project - Fxample Project.mpp

Ea File Edit Yiew Insert Format Tools Project ‘Window Help ﬂﬂ
DEE SRY $BRESL @ =@ 5 ¢ @ Meop - B @3,
|4 B & = Show- | Arial -3 -|lB I U All Tasks - T L
FI\gHt Control Uit
Tazk Mame Duration Start Finizh Predecessors  Resource 227,'05 Nar &, '05 har 13, '05 Mar 20, '05 Mar 27, '05 Apr 305 -
| | | MITwW[TIFls[sM[TwlTIFIs[sMmITwITIFls|sMTw[TF[s[sMITIw[TIFIs[sMITWTIF[S
1 51days Mon 12405  Mon 34105 v
2 Sdays | Mon 12405  Fri 12605
4 10 days  Mon 173105 Fri 241105
3 Sdays Mon 24405 Fri 2M8/05
] 10days Mon 22105 Fri 314005 CE——
10 18days  Mon 377105 Wed 3/30/05 [ % 7
1 [+ Interface to power source 2 days | Mon3705  Tue 3305 |
13 | £l FCU Control Interface 10days Wed 3905 Tue 332205
14 | Establish Cantral Requirements Tday|  Wed 3905 Wed 3805 12
15 Design cortrol interface 2days|  Thu 30MS Fri3m1i0s 14
15 | Prototype & test desion 4 days. Mon 34405 Thu 3MTI05 15
17 | Complete design Tday,  Fi3M8M5  Fri3M8m5 16
1| | Implement & test design Zdays| Mon 32105 Tue 322005 17
19 | C/DC Converters 3days Wed 372305  Fri32505
21 ¥l FCU Monitoring Interface 3days| Mon 3728105 Wed 3/30/05
73 | [ Integrate & Test Jdays  Thu 3305 Mon 4405 | (pE————
25 light Control Unit ] 10days| Mon2n405  Fri22s0s |
27 ata Archive Unit 10days Mon 3705  Fri3A8/05 v -
23 ata Archive Disk 3days Mon 32105 Wed 32305 | Ep—
31 | # Auxiliary Transmitter Sdays| Thu32405 Wed 330005 | P —
33 | [+ Mechanical Structure 10days | Tue 4505 Mon 418/05 R
35 hermal Control Sdays | Tue 4/19/05 Mon 42505 |
37 | [# System Integration & Test Gdays| Tue 426/05  Tue 5/3/05
. izl | Management 100 days Mon 12405 Fri 610/05 =
g Ad| KN | 3 | B l LIZJ
| Ready :

LSU rev20AUG2020 L24.02 MS Project Example 15
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Set the timescale of the chart

M &
g, e o
Noy guW?

ZaSPACR.

 From the “Format” menu select “Timescale”
« Set the Major Scale to Months
o Set the Minor Scale to Weeks

?x

Px

Timescale Timescale
Timescale Morwworking Time ] Timescale ] Monworking Time ]
Major scale Majar scale
Units: Label: |Jan 30, '00 :j ¥ Use Fiscal Year Units:  |Manths ¥ Label: |Januarv j ¥ Use Fiscal Year
Count: :.:;r:'ears Align: Left hd ¥ Tick lines Count: |1 _—:J align: Left hd ¥ Tick lines
Minor scale| Quarters Minor scale
’ Months . ) )
Units: Thirds of Manths Label: |SJ M, T, .. j ¥ Use Fiscal Year Units: va Label: |SJ M T, .. j ¥ Use Fiscal Year
Counk; | Weeks Align; Center  * IV Tick lines Count: Years Aligr: Center - v Tick lines
Days Half Years
General Haurs General Cuarters
Size:  |Minutes ¥ Scale separator Size: quths ¥ Scale separator
= | 2 Thirds of Manths
Presviewn Presyiew
Davs
5 Feh 27 '05 Mar 5 '05 Mar 13 '05 Mar 20, '05 fdat Haurs
wiT[FlslsMITw[T[FlsisM{TwiT[FlsisM[Tw[T[FlsisiMITw[T[FIs]s]| W|T|F|Minutes [slsmThalT[FissMITIwlTIF[S{sMITWTIFIs[s]
] Mone
o4 | Cancel I a4 | Cancel I

LSU rev20AUG2020
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Ballooning After timescale change

Course

ZaSPACR.

« Now the full Gantt chart from project start to end can be
displayed

& Microsoft Project - Example Project.mpp

@ File Edit Wiew Insert Format Tools Project ‘Window Help
DEE SRy 2R @ = B o @ NoGop - BT @ F,
|4 & & = show~- | Al -8 =B £ W | all Tasks - Tz L
Management
Task Mame Curation Start Finizh Pred | February | March | April [Mayy o
| | | | | 1r15|1r23|1r30]_2:5|2r13|2r20|2_r2?|3:5|3n3|3r20|3r2?_|4r3I4r10|4r1?|4r24|5n Isj
1 = Power System 51 days Mon 12405 Mon 4/4/05 & L
2 [+ Power Source 5days| Mon 12405  Fri1/28/05 b=
4 FCU Supply 10 days  Mon1/3105  Fri 2111/05 =
3 DAU HD Supply 5days Mon 21405  Fri2M8/05
& DAU Supply 10days Mon2/21/05  Fri /4005
10 = CubeSat Supply 18days  Mon 3705 Wed 3/30/05
FE [# Interface to power source 2 days | Mon 3705 Tue 3/8/05
13 | =l FCU Control Interface 10days Wed 3/9/05 Tue 372205
14 | Establizh Control Reguirements 1 day. Wiz 3!9.!’05. Wied 3805 12
15 Design control interface 2days  Thu3f DIDSI Fri3M1/05 14
16 | Protatype & test design ddays  Mon3A405  Thu3ATOS 15
17 | Complete design tday| Fri3M8OS  Fri3A80S 16
TE | Implement & test design Zdays  Mon 32105 Tue 352205 17
19 ¥ DC/DC Converters 3days Wed 3723005  Fri3/25/05
el [+ FCU Monitoring Interface 3 days | Mon 3/28/05 | Wed 3/30/05 |
| [ Integrate & Test 3days Thu3/3105 Mon 4/4/05 =
| # Flight Control Unit 10 days  Mon 24405 Fri 2/25/05
Data Archive Unit 10 days  Mon 3/7/05 [ Fri 318/05
Data Archive Disk 3days | Mon3/21/05 Wed 3/23/05
Auxiliary Transmitter Sdays Thu 372405 Wed 3/30/05
Mechanical Structure 10 days Tue 4/5/05 | Mon 418/05 { —
Thermal Control Sdays Tue 41905 Mon 425105 —y
System Integration & Test 6days Tue 42605  Tue 5/3/05 =y
Management | 75days Mon12ans  Fris6is P . : —p
. . H H -
i L ' fl
| Ready = [ ; "
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« To make a GIF image that can be inserted into documents, first
arrange the chart and task info boundaries to display just what
you want.

e From the “Edit” menu select “Copy Picture”
» Select “To GIF image file:” and enter a filename for the image

Copy Picture dld - Select what to copy: Rows
e on screen or Selected Rows

P * Select the timescale as

|Iu:uurse'l,Pru:ujeu:t ManagementiLecture 6\Example Project, gif Browse, ., either What iS Shown On the

Copy o

% Rows on screen Screen Or for SpeCIﬁC dateS

{~ Selected rows R . .
Tiescal e Click OK and the image will

¥ As shown on screen

 Erom: [Son 175705 ~| et [Sunsfeos ~ be generated-

| (54 | Cancel |
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Final version of project

« Below is the GIF image of the example project ready to be

inserted 1n a document.

[February [March [ april

May

ID | Task Name ‘
1 |Power System
2 Power Source
4 | FCUSupply
5] DAU HD Supply
& |  DAUSupply
10 CubeSat Supply
1 Interface to power source
| 13 | FCU Control Interface
| 14 | Estahlish Control Requirements
15 Design control interface
16 | Prototype & test design
[ 17 | Complete design
18 | Implement & test design
19 DC/DC Converters
21 FCU Monitoring Interface
23 Integrate & Test
|25 | Flight Control Unit
|27 | Data Archive Unit
| 29 |Data Archive Disk
31 |Auxiliary Transmitter
33 |Mechanical Structure
35 |Thermal Control
|37 System Integration & Test
39  |Management

P
—

19 [ 146 [123 [130 | 2 [ 213 | 220 [ 227 [ 38 [ 3M3 | 320 [ 327 [ 43 [ ano | an7 [ ar4 | sn
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